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Bienvenido a tu curso 

Autodesk Inventor Doblado de lámina y Soldadura. 

  

Gracias por tu confianza al inscribirte en este curso.  

 

Al término de este, conocerás las ventajas de utilizar el software CAD Inventor® ya 

que proporciona herramientas de calidad profesional para diseño mecánico 3D, 

documentación y simulación de productos. Los instructores brindan capacitación 

práctica para el desarrollo de prototipos digitales en la plataforma permitiendo 

conocer las herramientas fundamentales para la elaboración del producto. En la 

guía encontrarás descripciones, consideraciones y recomendaciones clave 

centradas en la implementación del proceso que ayudarán a cumplir las 

necesidades de tus trabajos. 

 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
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Capítulo 1 
 
 

Introducción. 
 
Concepto General. 
 
En las lecciones anteriores, hemos repasado los fundamentos de la creación de piezas y 
ensambles básicos.  En este módulo, examinaremos la funcionalidad de modelado de 
doblado de lámina y soldadura de Autodesk Inventor. 
 
 
 
 
Objetivo General. 

 
Al término del curso de Autodesk Inventor Ensamblajes y Explosivos se comprenderá la 
metodología de modelado de ensamblaje, desde la selección de la plantilla adecuada 
para trabajar, y la interacción con las herramientas para restringir, presentar, analizar, y 
documentar el desarrollo del ensamblaje.  
 
 
Contenido General. 
 
Capítulo 2: Doblado de lámina 
 
Capítulo 3: Soldadura 
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Capítulo 2 
 
 
 

Doblado de Lámina. 
 
 
 
 

 

 
 
 
 

 

Objetivo. 
 
 

• Conocerá el entorno de doblado de lámina. 

 

• Comprenderá y aplicará las herramientas para generar piezas de lámina. 

 

• Conocerá las operaciones base. 
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Contenido. 
 

 

1. ¿En qué se diferencian las herramientas de modelado de pieza con las de doblado 
de Lámina? 

 
2. Valores por defecto de Chapa. 

 
3. Operaciones Base. 

 
4. Operaciones Secundarias de Borde. 

 
5. Adición, Eliminación y Deformación de Material. 

 
6. Plegado y Desplegado (Fold & Unfold) 

 
7. Flat Pattern. 

 
8. Documentación 
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¿En qué se diferencian las herramientas de modelado de piezas y las de doblado de 
lámina?  
 
Muchas de las herramientas de chapa se basan en herramientas de modelado de piezas 
que se han mejorado especialmente para el diseño de chapa.  
Por ejemplo, al crear una cara de chapa, se selecciona el perfil igual que en Extrusión. El 
sistema realiza una extrusión del perfil por medio del grosor del material y puede añadir 
un pliegue al mismo tiempo. Las herramientas de modelado de piezas son necesarias en 
algunas de las más complicadas operaciones de chapa, como por ejemplo hoyos y 
respiraderos. Las herramientas diseñadas especialmente para chapa incluyen Pliegue, 
Esquina y Punzónado. 
 
El diseño de chapas se presta por sí mismo a la optimización. Una chapa tiene un 
espesor uniforme. Para fines de fabricación, los detalles como radios de plegado y 
tamaños de desahogo normalmente son los mismos en toda la pieza. En una pieza de 
chapa, se especifican valores para estos detalles y, a continuación, el software los aplica 
en el proceso de diseño. Por ejemplo, cuando crea una pestaña, no tiene que añadir el 
pliegue manualmente. 
Otra diferencia entre el diseño de chapas y el modelado de piezas reside en el desarrollo. 
Dado que las piezas de chapa se inician como una pieza plana de metal, es necesario 
convertir el modelo plegado en un desarrollo por razones de fabricación. El desarrollo se 
puede ver en una ventana independiente de la pieza plegada. 
 
Valores por defecto de Chapa. 
 
Los Valores por defecto de chapa se usan para aplicar distintos estilos a la pieza de 
chapa activa. Los cambios se aplican localmente en la pieza. 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal ► panel Setup ►Valores 

por defecto de chapa , o bien haga clic con el botón derecho y seleccione 
Sheet Metal Defaults en el menú de comandos frecuentes. 

 
2. En el menú desplegable Sheet Metal Rule, seleccione Default mm. 

 
3. Asegúrese de que la opción Use Thikness from Rule se ha seleccionado. 

El campo de entrada Grosor está desactivado y muestra el grosor que se 
especificó para Sheet Metal Rule Style Test. 

 
4. En el menú desplegable Material, seleccione el material de su conveniencia. 

 
5. Pulse Apply. El programa aplica los estilos a la pieza. 

 
Operaciones Base. 
 
Sin importar el total de herramientas proporcionadas para doblado de lámina, solo 4 
herramientas son utilizadas para crear una operación base. 
Una operación base será la primera operación que aparecerá en nuestro árbol, como 
lo son: 
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• Face 

• Contour Flange 

• Contour Roll 

• Lofted Flange 
 

 
Face. 
 
La herramienta Face es una de las operaciones más simples, esta herramienta utiliza un 
sketch cerrado y como resultado se obtiene una extrusión simple con la altura establecida 
como el parámetro de Grosor de la lámina. 
 
Para empezar, cree un boceto de un perfil que represente la forma de la cara de 
chapa que desea crear. 
 
1.En la cinta de opciones, haga clic en la ficha Sheet Metal panel Create Face. 

 
Si solo existe un perfil en el boceto, se resaltará. 
 
2. Si existen varios perfiles, haga clic en Profile, a continuación, seleccione un perfil para 
la cara de la chapa. 
 
3. Para cambiar la dirección del grosor de la cara, haga clic en Offset Direction. 
 

 
 
4. Haga clic en OK para crear la cara y close, o bien, para crear caras de chapa 
adicionales, haga clic en Apply. 
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Contour Flange. 
 
Una pestaña de contorno se define usando un boceto de perfil y una arista recta en una 
cara existente. El boceto de perfil se compone de líneas, arcos, splines y arcos elípticos. 
La geometría contigua del perfil da como resultado pliegues en el contorno que cumplen 
con el valor de radio de plegado del estilo de chapa. 
 
1. En la cinta de opciones, haga clic en la ficha Sheet Metal ► Panel Create ►Contour 

Flange.  
 
2. Seleccione un perfil abierto. 
 
3. Se muestra una vista previa del grosor del material de la pestaña. 
El grosor del material de la pestaña se crea a lo largo del perfil seleccionado hacia el 
material de la arista seleccionada. Para especificar que el grosor del material se cree 
fuera del perfil seleccionado relativo al material de la arista seleccionada, haga clic en el 
botón central (ubicado bajo el campo de selección de aristas) 
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4.En Radio de plegado (Bend Radius), acepte el radio de plegado por defecto o 
especifique uno si prefiere un pliegue diferente al del estilo de chapa actual. 
 

 
 
5.En la opción Distancia (Distance), especifique una distancia de extrusión. Para definir la 
dirección de extrusión en relación con el plano de boceto del perfil, pulse Dirección. 
 

 
 
6.Pulse Aceptar. 
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Contour Roll. 
 
La herramienta Contour Roll es una variación de la herramienta Contour Flange tool. Para 
crear un Rollo de Contorno (Contour Roll), se requiere realizar un perfil abierto, pero en 
vez de extruirlo se realiza una revolución. La geometría del boceto se limita a líneas y 
arcos, y la herramienta agregará automáticamente una curva en la intersección de las 
líneas. 
 

1. Para obtener una operación base, cree un boceto de perfil formado por líneas, 
arcos, splines y arcos elípticos (según sea necesario). Incluya una línea que 
represente el eje de rotación en el boceto o asegúrese de que el boceto esté 
situado de forma que pueda utilizar uno de los ejes por defecto como eje de 
rotación. 

 

 
 
Nota: Del mismo modo que la operación de pestaña de contorno, la operación de curva 
de contorno transforma las esquinas agudas del boceto en pliegues en la pieza terminada 
usando el valor del radio de plegado. 
 

2. Salga del boceto. 
 

3. En el panel Create de la ficha Sheet Metal, pulse Contour Roll. 
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4. Pulse la geometría del perfil para su revolución. 
 

 
 

5. En el cuadro de diálogo Contour Roll, haga clic en el comando de selección de 
ejes. 

 
 

6. Seleccione el eje de rotación. 
 
Nota: La geometría del eje de rotación debe estar incluida en el boceto que contiene la 
geometría del perfil. 
 

7. Si es necesario, modifique la dirección del desfase del material de la curva del 
perfil. 
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8. Si es necesario, cambie la dirección o el valor de Ángulo de curva. 
 

 
 

Nota: Puede utilizar un valor de ángulo de curva de 360 grados solo para los perfiles que 
tienen una única línea recta. En los perfiles de varios segmentos, el valor de ángulo no 
equivale a 360 grados. 
 

9. Pulse Aceptar para crear la curva de contorno y cerrar el cuadro de diálogo. 
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Lofted Flange. 
 
La herramienta Lofted Flange crea formas de chapas ocupadas regularmente en las 
transiciones de HVAC y tolvas. La figura muestra una transición de cuadrado a redondo, 
en la cual básicamente se crearon bocetos de principio y fin de la transición para luego 
utilizar la herramienta Lofted Flange. 
 

 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal ► panel Create► Lofted 
Flange. 
 

 
 

2. En la ventana gráfica, haga clic en la geometría visible del boceto que define el 
primer perfil del lofted flange. 

 
3. Haga clic en la geometría visible del boceto que define el segundo perfil del lofted 

flange. 
 

4. En la ficha Forma del cuadro de diálogo Pestaña solevada, haga clic en la opción 
de salida Moldeada (Die Formed) o Plegadora (Press Brake). 

 
5. Si es necesario, especifique un valor de radio de plegado distinto del definido en la 

regla de chapa activa. 
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Operaciones Secundarias de Borde. 
 
Flange. 
 
Un gran número de piezas de chapa se crean plegando una parte de la lámina plana. Use 
el comando Pestaña (Flange) para añadir material plano a lo largo de una arista, una 
parte de una arista o alrededor de todas las aristas de una cara. El material plano se une 
a la arista seleccionada mediante el radio de plegado que se ha definido en la regla de 
chapa. 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal► panel Create ►Flange, 
o bien haga clic con el botón derecho y seleccione Flange en el menú de 
comandos frecuentes. 
 

 
 

2. En la ventana gráfica, pulse para seleccionar las aristas internas deseadas. 
Ejemplo: 

 
 
Puede verse una vista preliminar de la operación Pestaña a medida que selecciona las 
aristas. Tenga en cuenta que las pestañas creadas a partir de aristas coplanares se 
aplicarán en bisel automáticamente en las esquinas que, de lo contrario, interferirían. 
 
Nota: Para esta pestaña, asegúrese de seleccionar las tres aristas interiores. 
 
Puede cambiar la Posición del pliegue a Plegar desde la cara adyacente, que usa la arista 
seleccionada como inicio del pliegue de la pestaña. 
 

1. Seleccione una de las opciones etiquetadas Plegar desde la cara adyacente 
en Posición del pliegue. 
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Para ver este cambio de manera más clara, visualice el modelo como Representación 
alámbrica (Wireframe) (ficha View ►panel Appeareance ►Representación alámbrica 
(Wireframe) desde el menú desplegable Visual Style) y vea el modelo desde la parte 
superior. 
 

2. Pulse Aceptar para crear la pestaña y cerrar el cuadro de diálogo Pestaña. 
 

 
 
Contour Flange. 
 
Además de ser una operación base, también se puede utilizar para añadir pestañas a una 
entidad existente. 
La herramienta Contour Flange utiliza perfiles abiertos como bocetos, con lo cual es ideal 
para crear formas complejas. El boceto generado debe ser generado en un plano 
perpendicular al borde donde se quiere generar la pestaña. Si el perfil del boceto es 
coincidente con un borde, una curva de forma automática se posicionará para conectar el 
boceto a la cara. Si el dibujo no es coincidente con un borde de referencia y la medida de 
distancia es modificada, el resultado será una pestaña que no esté conectada a la parte. 
 
Ejemplo: 
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Hem. 
 
Un reborde plegado a lo largo de las aristas de la chapa añade rigidez a un diseño. Las 
operaciones de reborde de chapa se suelen añadir para proporcionar uno o más grosores 
de material a lo largo de la arista de una cara o pestaña. Un reborde proporciona la rigidez 
a un diseño o proporciona una arista externa suave y redondeada en una pieza para 
eliminar las aristas rectas. 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal► panel Create► Hen 

(Reborde).  
 

2. En la lista desplegable, haga clic en un tipo de reborde: Single, Teardrop, Rolled o 
Double. 
 

 
 
 
En Forma: 
 

• Elija la cara Arista. También puede pulsar Cambiar dirección. 
 

• Acepte los valores por defecto definidos por el estilo de chapa activo o especifique 
un valor de separación y longitud del reborde, o de radio y ángulo, dependiendo 
del tipo de reborde especificado 
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3. Para especificar la extensión, haga clic en Más. En la lista desplegable, seleccione 
una opción: 

 

• Arista (Edge) Permite crear el reborde en la arista seleccionada. 
 

• Anchura (Width) Permite definir un desfase desde un punto inicial y una anchura 
de reborde. 

 

• Desfase (Offset) Permite definir los desfases desde los puntos inicial y final del 
reborde, o desde las caras planas que intersecan la arista seleccionada. 

 

• Desde-Hasta (From to) Permite el inicio y fin del reborde desde los puntos 
seleccionados, o desde las caras planas que interseca la arista seleccionada. En 
la lista desplegable, puede utilizar Medir, Mostrar cotas o Mostrar parámetros para 
obtener un valor del modelo 

 
 

4. Haga clic en Aceptar o en Aplicar para añadir más rebordes. 
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Adición, Eliminación y Deformación de Material. 
 
Cut. 
 
La herramienta de corte crea un agujero en base a un perfil cerrado. Esta herramienta nos 
ayuda a simplificar la operación de extrusión que comúnmente se utiliza, ya que los 
valores de los parámetros por defecto corresponden al espesor de la chapa, y por lo tanto 
corta automáticamente la pieza; en caso de verse afectado el espesor de la chapa, el 
valor de corte también se modificará por default. 
 
Para empezar, cree el boceto de un perfil que represente la forma del material que desea 
suprimir. 

1. En la cinta de opciones, pulse ficha Sheet Metal► panel Modify► Cut.  
Si solo existe un perfil en el boceto, se resaltará automáticamente. 

 
2. Si hay varios perfiles, pulse Profile y designe el perfil para el corte. 

 
Nota: Si el perfil de boceto se solapa con un pliegue, el comando Cortar elimina material 
en función de la extensión y la dirección definidas. Utilice Corte en pliegue para crear un 
corte de profundidad total o parcial que envuelva el pliegue. 
 
 
3. En el grupo de opciones Extensión (Extents), pulse la flecha abajo y pulse el método de 
acabado de la extrusión: 
 

• Distance En la lista desplegable Grosor, pulse el método para determinar el 
grosor. Seleccione la dirección del corte. 

 

• To Next Pulse una dirección para especificar la dirección del corte. 
 

• To Pulse la cara en la que desea que termine el corte. Especifique si el corte se 
extiende más allá de la cara seleccionada. 

 

• From-To Pulse las caras de inicio y fin del corte. 
 

• All Pulse la dirección del corte. 
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4. Pulse Aceptar. 

 
 
 
Punch Tool. 
 
Punch Tool son iFeatures con atributos adicionales que cortan agujeros de formas 
simples o complejas en una cara, o través de una curva. Punch tool pueden penetrar 
parcialmente la cara de la chapa y dejar una huella en relieve, o cortar en una sola 
operación. 
 
Se pueden incorporar iFeatures de punzones dentro de los modelos de chapa. Para crear 
punzones como iFeatures se utiliza un ambiente de parte en el cual se trazan los bocetos 
y las operaciones necesarias para representar el mismo. No se crea un modelo el 
herramental físicamente. Para ello antes de guardar el modelo se crea una tabla Punch 
iFeature. 
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Para colocar un corte o una forma repujada en una cara de chapa. 
 

 
 
La herramienta de punzonado debe tener un boceto con una sola marca de centro 
definida. La cara de chapa debe tener un boceto con una o varias marcas de centro 
consumidas. 
 
1. En la cinta de opciones, haga clic en ficha Sheet Metal► panel Modify ►Punch 
Tool 
 

 
 
2. En el cuadro de diálogo Directorio de punzones, desplácese hasta una carpeta que 
contenga formas de punzonado y haga clic en una de ellas. El cuadro de diálogo muestra 
una vista preliminar de la forma de punzonado seleccionada. 

 

 
 
3. Haga clic en Abrir para seleccionar la forma de punzonado. Se cerrará el cuadro de 
diálogo Directorio de punzones y se abrirá el cuadro de diálogo Punzonado. 
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4. En el cuadro de diálogo Punch Tool, especifique si desea aplicar el punzonado en un 
doblez (Across Bend). 
 
5. En el área gráfica, si tiene más de un centro en el boceto, mantenga pulsada la tecla 
CTRL mientras hace clic en las ubicaciones en las que no desea que se inserten 
punzonados. 
 
6. En la ficha Geometry, especifique un ángulo para girar el punzonado con respecto a la 
cara (si es necesario). 
 
7.Si se muestra geometría sin resolver, seleccione el estado en la lista del cuadro de 
diálogo. A continuación, haga clic en la cara de chapa y utilice los comandos adecuados 
para la resolución. 
 
8. En la ficha Size, haga doble clic en un valor de parámetro para cambiarlo, si es 
necesario. 
 
9. Pulse Terminar para punzonar la forma en la cara de la chapa. 
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Corner Round. 
 
Elimine las esquinas agudas del material de chapa plana. 
 
Se pueden añadir redondeos tanto a las esquinas interiores como exteriores. Los 
redondeos de esquina se aplican normalmente a las piezas de chapa para eliminar las 
esquinas agudas del material plano o para el corte continuo de formas de pieza a partir de 
desarrollo de chapa plana. Se pueden añadir redondeos tanto a las esquinas interiores 
como exteriores. 
Puede crear empalmes o redondeos de diferentes tamaños en una sola operación. Todos 
los empalmes o redondeos creados en un solo proceso son una sola operación. 
 
Añade empalmes o redondeos a uno o varios vértices de una pieza de chapa. 
 

 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal ►panel Modify ►Corner 

Round.  
 
2. Especifique el radio para el primer conjunto de aristas. 

 
3. En el modo de selección, haga clic en Corner o Feature. 

 
4. En la ventana gráfica, seleccione las aristas de modelo que representan vértices. 

 
5. Para añadir redondeos con un radio diferente, seleccione otro conjunto de aristas. 

 
6. Pulse Aceptar para aplicar las operaciones de vértice. 
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Corner Chamfer. 
 
Los chaflanes eliminan los ángulos agudos del material de chapa plano. 
 
Los chaflanes de esquina se aplican normalmente a las piezas de chapa para eliminar los 
ángulos agudos del material plano. El comando Chaflán de esquina ofrece opciones que 
permiten crear chaflanes utilizando: 
 

• Una distancia específica 

• Una distancia y un ángulo 

• Dos distancias 
 
Puede añadir chaflanes a una o varias esquinas de una pieza de chapa. 
 

 
 
1.En la cinta de opciones, pulse la ficha Sheet Metal► panel Modify► Corner Chamfer 

 
 

2.Pulse una distancia. 
 
3.Seleccione las esquinas que desea achaflanar. Solo puede seleccionar las aristas 
de modelo que representan esquinas. 
 
4.Especifique una distancia de chaflán. 

 
5. Pulse Aceptar. 
 
Creación de chaflanes de esquina con distancia y ángulo. 
 

1. En la cinta de opciones, pulse la ficha Sheet Metal► panel Modify► Corner 

Chamfer.  
 

2. Seleccione Distancia y ángulo. 
 

3. Seleccione la arista de chapa a partir de la cual se aplica un ángulo al chaflán y, a 
continuación, designe una esquina o las dos en la arista de chapa. Puede 
seleccionar aristas de chapa y de modelo que representen esquinas. 

 
4. Especifique una distancia y un ángulo de chaflán. 

 
5. Pulse Aceptar. 
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Creación de un chaflán de esquina a partir de dos distancias. 
 
 

1. En la cinta de opciones, pulse la ficha Sheet metal ►panel Modify► Corner 

Chamfer.  
2. Pulse Dos distancias y designe la esquina en la que desee insertar el chaflán. 

Puede seleccionar solamente una arista de modelo que represente una esquina. 
 

3. Especifique un valor para Distancia 1 y Distancia 2. Si lo desea, en la lista 
desplegable de valores introducidos recientemente, pulse una de ellas. 
 

4. Si lo desea, pulse Cambiar para invertir las distancias en el modelo. 
 

5. Pulse Aceptar. 
 
 

 
 

 
 
 
 
 
 
 
 



28 
 

Fold. 
 
Un pliegue en una cara de chapa que forma una línea de plegado en un boceto a partir de 
una línea recta que termina en aristas de la cara. 
 
A diferencia de las operaciones de pliegue, pestaña, pestaña de contorno o reborde que 
añaden material al diseño, la operación de plegado no añade material.  
 
Pliegue una cara de chapa por una línea de boceto. 
 

 
 

1. En la cinta de opciones, pulse la ficha Sheet Metal► panel Create► Fold. 

 
 

2. Pulse la línea de plegado que se va a utilizar para el pliegue. La línea de plegado 
debe estar en la cara objeto de plegado y debe terminar en las aristas de la cara. 

 
3. Especifique la ubicación de la línea de plegado. Pulse para indicar si la línea define 

el eje, el inicio o el fin del pliegue. 
 

4. Acepte el radio y ángulo de plegado especificados en el estilo actual de la chapa o 
especifique un valor diferente. 

 
5. Para definir el lado y la dirección del pliegue, pulse Cambiar lado y Cambiar 

dirección. 
 

6. Pulse Aceptar. 
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Bend. 
 
Las operaciones de pliegue pueden unir caras de chapa creadas en una ubicación 
concreta para cumplir con criterios de diseño específicos. Al seleccionar aristas en 
operaciones de chapa, se añade material al modelo con el radio de plegado y el grosor 
del material definidos por el estilo de chapa. 
 
Las caras se alargan para que sean compatibles con el radio de plegado por defecto (o 
seleccionado). Si las caras son paralelas, pero no coplanares, puede añadir un doble 
plegado. Dependiendo de la distancia entre las caras, los pliegues se recortan para que 
sean tangentes o se crea una cara entre los dos pliegues. 
 
Cree un pliegue en una pieza de chapa. 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal► panel Create► Bend. 

 
2. Seleccione una arista de modelo en cada cara de chapa. 

 
3. Si es necesario, seleccione Alargar pliegue alineado hasta caras de lado. 

 
4. Acepte el radio de plegado por defecto especificado en el estilo de chapa activo o, 

en la lista desplegable, haga clic en Medir, Mostrar cotas o Mostrar parámetros 
para introducir un valor diferente. 

 
5. Haga clic en Aplicar para seguir añadiendo pliegues o en Aceptar para cerrar el 

cuadro de diálogo. 
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Plegado y Desplegado (Fold & Unfold). 
 
En ocasiones, las operaciones de chapa atraviesan áreas de pliegue de la pieza 
terminada. La pieza se puede aplanar para crear estas operaciones. Con las operaciones 
de desplegado y replegado puede realizar lo siguiente: 
 

• Insertar una operación de desplegado en el historial de operaciones de la pieza 
para aplanar todos los pliegues y las curvas o únicamente los seleccionados. 

 

• Añadir operaciones al modelo en el estado aplanado. 
 

• Insertar una operación de replegado para devolver las operaciones añadidas tras 
la operación de desplegado al estado plegado original. 

 
Desplegar añade una operación de desplegado al navegador de piezas de chapa. Puede 
añadir otras operaciones a la sección aplanada del modelo. A continuación, se puede 
añadir una operación de replegado para replegar todos los pliegues o las curvas que se 
han desplegado o algunos de ellos. 
 
Tras una operación de replegado (en el historial del navegador), puede añadir otras 
operaciones al modelo plegado. Las operaciones de replegado sólo se pueden añadir a 
modelos de chapa que contienen una operación de desplegado en un estado desplegado. 
Puede desplegar o replegar bocetos creados en las caras plegadas o desplegadas de una 
pieza de chapa. Las cotas de estos bocetos pueden hacer referencia a otras operaciones 
en estado plegado o desplegado. 
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Unfold: 
 
Permite desplegar uno o varios pliegues o curvas de chapa con respecto a una cara de 
referencia. 
 
Utilice este procedimiento en un modelo con al menos una cara plana. 
 

1. En la cinta de opciones, haga clic en la ficha Sheet Metal► panel Modify► Unfold. 

 
 
2. Pulse una cara o un plano que desee usar como referencia de Desplegar. 

 
3. Pulse en curvas o pliegues resaltados individuales que desee desplegar. Para 

seleccionar toda la geometría resaltada, utilice Añadir todos los pliegues y, a 
continuación, utilice CTRL + clic para eliminar los pliegues o las curvas de la 
selección. 

 
4. Obtenga una vista preliminar del estado aplanado y añada o suprima pliegues o 

curvas para llegar al estado plano deseado. 
 

5. Seleccione los bocetos no consumidos que desee desplegar. 
 

6. Pulse Aceptar. 
 
 
Se añade una operación de desplegado al navegador de piezas de chapa. 
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Refold: 
 

1. En la cinta de opciones, haga clic en ficha Sheet Metal► panel Modify► Refold. 

 
 

2. Haga clic en una cara o un plano que desee usar como referencia de Replegar. 
 

3. Pulse en curvas o dobleces resaltados individuales que desee replegar. Para 
seleccionar toda la geometría resaltada, utilice Añadir todos los pliegues y, a 
continuación, utilice CTRL + clic para eliminar los pliegues o las curvas de la 
selección. 

 
4. Obtenga una vista preliminar del estado replegado, y añada o suprima pliegues o 

curvas según sea necesario. 
 

5. También puede seleccionar los bocetos no consumidos que desee replegar. 
 

6. Pulse Aceptar. 
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Flat Pattern. 
 
Ha terminado de añadir operaciones al modelo plegado. Muchas de estas operaciones 
han añadido plegados usando el radio de plegado por defecto. Algunas de las 
operaciones han dejado separaciones o destalonados usando reglas de la regla de chapa 
activa. Cuando se aplana el modelo plegado, las operaciones tienen como resultado una 
lámina plana a la que se le pueden añadir detalles a modo de preparación para la 
fabricación. En el desarrollo se muestran las líneas de plegado y las extensiones de 
pliegue. Asimismo, durante la creación de un dibujo del desarrollo se pueden recuperar 
los atributos de las iFeatures de punzonado. 
 
1. En la cinta de opciones, pulse la ficha Sheet Metal► panel Flat Pattern► Create Flat 
Pattern. 
 
Puesto que está trabajando en una pieza de chapa que está activa en un ensamblaje, el 
archivo de pieza de chapa se abre de forma independiente y se crea el desarrollo. 
 
 

 
 
2. Pulse dos veces el icono Modelo plegado en la parte superior del navegador de modelo 
para volver al modelo plegado. 
 
Nota: Si lo prefiere, también puede hacer clic en ficha Flat Pattern► Folded Part► Go to 
Folded Part para volver al estado del modelo plegado. 
 
3. Pulse Guardar 
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Documentación. 
 
Creación de Vistas de Chapa Metálica. 
 
El primer paso en la creación de la documentación será la de elegir qué modelo de 
expediente de referencia, pero con chapa viene con el requisito añadido de decidir entre 
un modelo y un flat pattern en vista de modelo. Una vez que se selecciona un archivo de 
modelo de chapa en la ficha componentes, el grupo Opciones Sheet Metal aparecerá 
inmediatamente debajo de la información de la ruta del archivo. 
 
Las opciones que se muestran le permiten elegir entre crear un flat pattern o al patrón de 
vista. Las opciones de la vista por defecto cambiarán en función de su selección, ya que 
el flat pattern tiene una clara distinción entre su parte superior (por defecto) y su cara 
inferior (cara posterior). 
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Adding Bend, Punch, and Flat Pattern Annotations. 
 
Una vez que hayas creado tu vista del componente de chapa, puede cambiar a la ficha 
Dibujo Annotate para completar la documentación de su diseño. Las herramientas de 
anotación son específicas en vistas de patrones. Puede añadir notas de pliegue y ponche 
notas. 
 

 
 
Anotaciones de pliegue (Bend Annotations). 
 
Una nota de pliegue añade información de fabricación a los ejes de pliegue de chapa. Las 
notas de pliegue se asocian a una vista de dibujo. Una tabla de plegado muestra las 
propiedades de todos los plegados incluidos en una vista de desarrollo de una pieza de 
chapa. 
 
Los identificadores de plagado asocian las filas de una tabla de plegado con la geometría 
de la vista. Después de insertar la tabla de plegado en el dibujo, se añaden 
automáticamente los identificadores de plegado a dicha vista. El estilo de cota aplica 
formato a los identificadores de plegado y, por defecto, no tienen directriz. Arrastre el texto 
del identificador de plegado lejos de la posición original para añadir una directriz al 
identificador de plegado. 
 

 
 

1. En la cinta de opciones, pulse ficha Annotate► panel Table► General.  
 
2. En la hoja de dibujo, seleccione una vista de dibujo de desarrollo de una pieza de 

chapa. 
 

3. En el cuadro de diálogo Tabla: 
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• Haga clic en Selector de columna y añada o elimine columnas de la tabla de 
plegado. 

• Defina el formato de la cadena BEND ID. 
 

4. Pulse Aceptar para cerrar el cuadro de diálogo. 
 

5. Inserte la tabla en la hoja de dibujo. 
 
 
Anotaciones de punzado (Punch Annotations). 
 
 

1. Pulse ficha Annotate► panel Table► vista Hole. 
 

2. Seleccione una vista de dibujo de desarrollo para asociar con la tabla de 
punzonado. 

 
3. Haga clic en un punto en la vista para colocar la indicación de origen. 

 
4. Pulse para insertar la tabla de punzonado. 
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Capítulo 3 
 
 

Soldadura. 
 
 
 

 

Objetivo. 
 

 
• Conocerá las ventajas del Content Center 

• Conocerá como crear patrones de componentes en ensambles 

• Conocerá la interfaz de presentación 

• Conocerá como simular restricciones 

 
 
 
 
Contenido. 
 

• Soldadura  

 

• Creación de patrones 

 

• Reemplazo de componentes 

 

• Explosivos (Archivos de simulación) 
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Soldadura. 
 

Con este enfoque, se utiliza una mezcla de estética, filete y soldaduras de ranura con los 
preparativos, las características de mecanizado, y símbolos de soldadura a nivel de 
ensamble. En La lista de materiales se describen los diferentes componentes de la parte. 
El análisis de elementos finitos (FEA), no excluye el conjunto de soldadura, ya que puede 
derivar en una parte. Es posible hallar este enfoque difícil al principio, pero se pueden ver 
grandes ganancias en productividad posteriores al documentar la soldadura. Este enfoque 
es recomendado para grandes piezas soldadas sí necesita propiedades de masa, análisis 
de interferencia, y documentación completa. (Ejemplos de ello son los marcos 
estructurales, tuberías, puertas industriales, cercas y muebles de acero.) 
 
Un diseño de ensamblaje de conjuntos soldados es una extensión del entorno de 
modelado de ensamblajes. Existen dos métodos para crear conjuntos soldados. En el 
entorno de conjunto soldado, usa una combinación de comandos de ensamblaje y 
específicos de las soldaduras. En el entorno de ensamblaje, convierte el ensamblaje en 
un conjunto soldado. Una vez convertido, puede añadir soldaduras. 

 
En conjuntos soldados de ensamblaje, puede crear ensamblajes, añadir opcionalmente 
operaciones de ensamblaje con el fin de preparar modelos para soldaduras, añadir las 
soldaduras como operación ficticia o sólida y, a continuación, añadir más operaciones de 
ensamblaje para operaciones de mecanizado final. Cuando el modelo de conjunto 
soldado está completo, todas las piezas y operaciones se guardan en un solo archivo de 
ensamblaje, que se denomina conjunto soldado. 
 
Puede convertir un ensamblaje en un conjunto soldado en cualquier momento. 
 
Nota: Una vez convertido un ensamblaje en un conjunto soldado, no puede revertirse a 
un ensamblaje. Para mantener una versión de un ensamblaje antes de convertirlo en 
conjuntos soldados, guarde el archivo con otro nombre. 
 

1. Abra un archivo de ensamblaje existente. 
 
2. Asegúrese de que su modelo se actualiza y de que no se encuentra en estado de 

recuperación. 
 

3. En la cinta de opciones, pulse la ficha Enviroments► panel Convert► Convert to 
Weldment. 
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4. Seleccione la norma que va a usar. El valor por defecto es la norma seleccionada 
durante la instalación. 
 

 
 

5. Seleccione el material que se va a utilizar por defecto para todos los cordones de 
soldadura. 

 
 

6. Seleccione la estructura de lista de materiales que prefiera en la lista. 

 
7. Pulse Aceptar. 

 

 

Modelado de Preparaciones. 
 
Imagínese que usted ha creado el conjunto de piezas soldadas para un envase en caja y 
desea agregar cordones de soldadura. Antes de añadir los cordones de soldadura, el 
montaje necesita preparaciones de soldadura para crear espacio para el cordón de 
soldadura que se colocará. Usted puede modelar una variedad de características de 
preparación para eliminar material. Tenga en cuenta que los 

preparativos están en el ensamble, lo que significa que existen sólo en ensamble y no en 
el nivel de pieza. A continuación, se mencionan las características de preparación más 
comunes: 

 

• Extrude 

• Revolve 

• Hole 

• Sweep 

• Chamfer 

• Move Face 
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Las soldaduras de ranura están clasificadas por diferentes tipos de preparaciones de 
soldadura. Aunque la mayoría de las soldaduras de ranura no requieren más que un 
simple chaflán, en la mayoría de los casos las soldaduras de ranura requieren algún tipo 
de preparación. 

 

 
 

Para realizar las preparaciones se requiere la construcción de la forma con el boceto y 
posteriormente una operación (extrusión, revolución, barrido). Sin embargo, se 
recomienda que utilice hizo la función de preparación de soldadura, lo que ayuda a 
mostrar el proceso de fabricación. Además de ayudar en la documentación de la 
soldadura en un dibujo. 

 

Ejemplo, para crear una preparación: 

 

1. Haga doble clic en la carpeta Preparativos en el árbol de operaciones para activar 
las funciones de cordón de soldadura, o haga clic en la ficha Weld >> panel 
Process >> herramienta Preparation. 
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2. Haga clic en el botón Chamfer en el panel Preparation and Machining, y seleccione 
uno de los bordes interiores de su ensamble o pieza. 

 

     
 

3. Establecer un tamaño del chaflán, y haga clic en Aceptar. Salga del entorno de 
preparación, ya sea haciendo clic en el botón Volver o haciendo clic derecho y 
seleccionando Terminar edición. 
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Soldadura Cosmética. 
 
Los cordones de soldadura ficticia resultan útiles cuando el diseño no requiere análisis de 
interferencias, ni el aspecto estético de cordones de soldadura sólidos. Sus propiedades 
físicas aproximadas se pueden incluir en las propiedades másicas. 

 

Acceso: 
 
Pulse con el botón derecho la carpeta Soldaduras en el navegador y seleccione Editar. En 

la cinta de opciones, haga clic en la ficha Weld► panel Weld► Cosmetic.  

 

La casilla Cosmetic Weld indica los parámetros necesarios para construir el cordón 
ficticio. 

 
Seleccionar modo 

 

Define la preferencia de selección para zonas en las que se aplica el cordón de soldadura 
ficticia. Arista (Edge) es el valor por defecto. La opción Cadena (Chain) selecciona 
automáticamente aristas tangentes y contiguas. La opción Contorno (Loop) selecciona un 
contorno cerrado. 

 
Espesor 
 

Determina el método de tratamiento de una soldadura ficticia. Una soldadura ficticia 
puede terminar en un plano de trabajo o ampliarse por toda la geometría seleccionada de 
una soldadura de longitud completa. Pulse la flecha para seleccionar el método de 
extensión (Extents). 

 

All crea la soldadura en todas las operaciones y los bocetos en la dirección especificada. 

 

From-To selecciona caras o planos de inicio y final en los que termina la operación de 
soldadura. En un conjunto soldado, las caras o los planos pueden estar en otras piezas, 
pero deben ser paralelos. 

 

Area 
 
Define el área de sección transversal para un cordón de soldadura ficticia de tal modo que 
puedan calcularse las propiedades físicas del cordón ficticio. 
 
Seleccione Crear símbolo de soldadura para expandir el cuadro de diálogo en el que se 
definen los parámetros del símbolo de soldadura. 
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Soldadura en Ángulo. 
 

Un cordón de soldadura su función es unir a dos conjuntos de caras. Una de las opciones 
en esta herramienta se conoce como Longitud de pierna (Leg Lenght); en esta opción se 
requieren introducir las dos longitudes de las piernas que se utilizan para generar el talón. 
La segunda opción es especificar la longitud de la garganta, este valor es la distancia 
desde la raíz de la soldadura hasta el fillet, e Inventor calcula el resto del tamaño del 
cordón de la soldadura. El valor de desplazamiento (offset) influye cuando la soldadura es 
cóncava o convexa. 
 
La forma de la tapa de una soldadura puede ser plana, convexa o cóncava. Para plana, el 
desplazamiento es 0. Para cóncava o convexa está basada en el offset. 
 

1. En el navegador de modelo, pulse dos veces el nodo Weld. 
 

2. En la cinta de opciones, haga clic en la ficha Weld► panel Weld► Fillet.  
 
Para una soldadura 3D, se deben seleccionar conjuntos de caras de dos componentes 
diferentes. El programa crea la soldadura en las aristas comunes de las caras. 
 

3. Pulse la cara adyacente a la base. 
 

 
 

Para completar la soldadura, seleccione la otra cara donde se va a realizar la soldadura. 

1. En el cuadro de diálogo, pulse el botón Seleccionar caras 2.  
 

2. Pulse la cara de la base de la pieza. 
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3. Introduzca 6 mm en los dos campos situados bajo los botones de selección. 
 

 
 

4. Presione OK. 
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Soldadura en Ranuras. 
 

Crea una operación de soldadura para ranuras en un ensamblaje de conjunto 
soldado que conecta dos conjuntos de caras con un cordón de soldadura sólido. 
Una soldadura de ranura se utiliza principalmente para llenar los vacíos entre dos 
conjuntos de caras. Una vez que sean llenadas, es posible colocar un cordón de 
soldadura. 
 
Acceso: 
Pulse con el botón derecho la carpeta Weld en el navegador y seleccione Edit. En la cinta 

de opciones, haga clic en la ficha Weld► panel Soldadura► Groove.  
 
 
La casilla Cordón indica los parámetros necesarios para construir la soldadura para 
ranuras 
 
Conjuntos de caras 1 y 2 (Bead {Face Set 1, Face Set 2}) 
Selecciona los dos conjuntos de caras que se van a conectar con un cordón de soldadura 
para ranuras. Cada cara debe estar formada por una o varias caras de piezas contiguas. 
 
 
Soldadura de cara completa 
 
Especifica el modo en que aparece el cordón de soldadura para los dos conjuntos de 
caras. 
Desactive la casilla de verificación para especificar que el cordón de soldadura finaliza en 
la extensión del conjunto de caras más pequeño. 
 

 
 
Active la casilla de verificación para especificar que el cordón de soldadura se extiende 
para consumir los dos conjuntos de caras. Si los conjuntos de caras 1 y 2 tienen 
longitudes distintas, el cordón de soldadura se expande para ajustarse a las dos caras. 
 

 
 
Encadenar caras 
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Dirección de llenado (Fill Direction). 
 
Define la dirección en la que se proyectan los conjuntos de caras de soldaduras para 
ranuras entre sí al conectarse mediante un cordón de soldadura para ranuras. Para definir 
la dirección de llenado puede seleccionar: 
 

• Caras planas y planos de trabajo (especifica la dirección normal a la cara o plano 
seleccionados) 

• Caras cilíndricas, cónicas o toroidales (especifica la dirección del eje de superficie) 

• Ejes de trabajo 

• Aristas de pieza 

• Dos puntos (eje de trabajo, vértice del modelo) 
 

 
 
Proyecta el cordón de soldadura en el ángulo del primero conjunto de caras seleccionado. 

 
 

 
 
Proyecta el cordón de soldadura perpendicularmente al segundo conjunto de caras 
seleccionado 
 

 
 

 
 
Relleno radial 
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Propiedades de la Soldadura. 
 
Se puede determinar el material de las soldaduras al inicio, o en su defecto realizadas 
todas las soldaduras correspondientes. Para modificar el material después de una 
operación realizada: 
 
1. Seleccionar del árbol Welds y dar click derecho. 
2. Dar click en IProperties. 
3. Ir a la pestaña Physical y cambiar el material de la soldadura. 
4. Dar click en Apply, Ok. 
 
Además que en la misma pestaña podemos conocer información sobre la soldadura, 
como lo son: 
 

• Masa. 

• Área. 

• Volumen. 

• Centro de gravedad. 
 
 
Documentación Soldadura. 
 
Para crear un dibujo de conjunto soldado. 
 

1. Abra una hoja de documentación extensión. idw. 
 

2. En la cinta de opciones, haga clic en la ficha Place Views► panel Create► Base. 

 Aparece el cuadro de diálogo Drawing View. 
 
Si nuestro archivo de ensamble soldadura es el único modelo abierto, se selecciona 
automáticamente como origen del dibujo. Si hay varios modelos abiertos, haga clic en la 
flecha hacia abajo situada junto a la lista File y luego seleccione el archivo que requiera 
documentar en la lista. 
 

3. En la ficha Model State, seleccione Welds de la lista Weldment. 
 

4. En la ficha Component, seleccione Master del menú Vista de representación. 
 

5. Seleccione una escala en la lista Scale. 
 

6. Pulse la orientación deseada para la documentación en la lista Orientation. 
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Adición o edición de símbolos de soldadura 
 
El estilo de símbolo de soldadura determina el tipo de línea, el grosor de línea, el color y la 
separación del símbolo. 
 
Consejo: si se ha creado un símbolo de soldadura en el modelo, al añadir manualmente 
un símbolo de soldadura se creará una copia del símbolo del modelo. Éste no se 
actualizará si se realizan cambios en el símbolo de soldadura. Para crear un símbolo de 
soldadura que se actualice con el símbolo de soldadura del modelo, pulse con el botón 
derecho del ratón en la vista de dibujo y seleccione Obtener anotaciones de modelo 
►Obtener símbolos de soldadura. 
 
Si no hay símbolos de soldadura en el modelo, puede crear un símbolo de soldadura 
no asociativo en la vista del dibujo. 
 

1. En la cinta de opciones, haga clic en la ficha Anotar panel Símbolos Soldadura. 

 
2. En la ventana gráfica, pulse para definir el punto inicial de la línea de directriz. 

 
 
Nota: Para asociar el símbolo de soldadura a la geometría, sitúe el cursor en la arista 
adecuada y pulse el ratón cuando la arista se resalte. Los símbolos asociados a la 
geometría se desplazan al mover la vista del dibujo. 
 

3. Desplace el cursor y pulse para añadir un vértice a la línea de directriz. 
 

4. Cuando el indicador de símbolo se encuentre en la posición correcta, pulse el 
botón derecho del ratón y elija Continuar para insertar el símbolo y abrir el cuadro 
de diálogo Símbolo de soldadura. La norma de dibujo activa determina las 
opciones del cuadro de diálogo. 

 
5. Defina los atributos y los valores del símbolo. 

 
6. Continúe insertando símbolos de soldadura. Cuando haya terminado, pulse con el 

botón derecho del ratón y seleccione Terminar. 
 
 
 
 

 


